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Disclaimer

This protocol applies to the version 2.6 of the PlanktoScope and the v2024.0.0 version of software. It is

optimized to image 20 µm-200 µm organisms using the 25 mm lens (as tube lens) and 12 mm one as

objective one and may be inaccurate with other configurations or light. Please note that the segmenter is

currently also optimized for this and may need to be recoded (or adjusted) for other configurations, notably

the size threshold but also the intensity threshold.
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Abstract

This protocol is for using PlanktoScope and collecting usable results for quantitative imaging of plankton. 

This project has received funding from the European Union’s Horizon 2020 research and innovation programme

“Atlantic Ecosystems Assessment, Forecasting and Sustainability” (AtlantECO GA#862923)

This research was co-funded by the European Union (GA#101059915 - BIOcean5D).

See also https://www.planktoscope.org/

Image Attribution

Fabien Lombard, Thibaut Pollina, Karine Leblanc, Will Major, Pierre Kostyrka, Adélaïde Perruchon

Guidelines

Planktoscope is an optical instrument. As it optical elements (camera, lenses, Flow Cell) are highly sensible to dust

and dirt. we recommend that you never touch any of those component with fingers and store the Planktoscope in

a dust free and humidity free area (or in a box when not used)

complete manual of assembly and software could be found at https://planktonscope.readthedocs.io/en/latest/

Materials

- Plankton net or other kind of microplankton collector

- 200 µm sieve

- Squizing bottle

- Micrometer slide (or millimetric ruller)

- Optical paper

- PlanktoScope box

- A computer

Softwares :

- ImageJ (last version, needs to compute RGB images)

- FileZilla

- Raspberry Pi Imager
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Safety warnings

Planktoscope is an electronic device, powered with electricity. It is therefore sensible to water. 

- Place it in an environment where water can not enter in contact with the instrument and secure its

electrical part. 

- Be careful when manipulating samples, take care of having the exhaust tube in a "trash" tube to avoid

spillage

- Glass parts are present (Flow Cell) and should be manipulated with caution (can break and injure you),

but also should be kept clean (avoid touching it with fingers)

- For an easiest navigation, you can see the table of contents by clicking on "Show the table of contents"

on the top left.

- Figures are numbered by section: 

If a figure is cited in its corresponding section, only the number will be cited (ex: Fig.1). 

If a figure is cited in a different section, the section and the number will be cited (ex: S3-Fig.1 for figure 1

of section 3).

Before start

-Test the protocol before acquisition of your first sample

-Calibrate your instruments to ensure coherent measures

-Create an Ecotaxa account and request the right to create project way before 

-Collect a plankton sample using a net
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1 1. Table of Contents go to step #1

2. Introduction go to step #2

3. Quick usage version go to step #3

4. Quality Checks reminder go to step #4

5. Assemble the PlanktoScope go to step #5

6. User Interface and initial connection go to step #6

7. White Balance calibration go to step #8

8. Pump calibration go to step #9

9. Size calibration go to step #7

10. Get your sample go to step #10

11. Pass the sample on the PlanktoScope go to step #11

12. Segment the Acquisition go to step #12

13. How to export data go to step #13

14. Clean the PlanktoScope go to step #14

15. Upload your images on EcoTaxa go to step #15

16. How to use efficiently EcoTaxa go to step #16

17. How to compute biovolumes go to step #17

18. Maintenance of your PlanktoScope go to step #18

19. Troubleshooting go to step #19

20. External links go to step #20

2 The PlanktoScope is a frugal, microfluidic microscope designed with an open-

hardware and open-software approach. It was conceived with the idea of providing

the thousands of scientists and sailors exploring the oceans with a high-quality

instrument suitable for deepening our knowledge of the sea around us. In this manual

you will learn how to operate the PlanktoScope and take images of plankton.

Table of Contents

Introduction
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3 This part is a quick version of the protocol, where you will find the essential steps to

follow. If you are using your PlanktoScope for the first time or need to calibrate it,

please read the full protocol. Do not wait too long between the sampling and the

processing of your sample through the PlanktoScope to avoid sedimentation and

aggregation.

3.1 Preparation

1. Assemble and plug in the PlanktoScope go to step #5

2. Connect to PlanktoScope’s Wi-Fi go to step #6

3. Go to http://192.168.4.1 or http://192.168.5.1 or http://planktoscope.local or 

http://planktoscope.local or http://home.pkscope > Node-RED Dashboard

4. Fill ALL the sample metadata (in "Sample") [Critical] go to step #11.1

5. Turn on the light  (in "Optic Configuration") 

6. Check the WB parameters (you should have already done the calibration during the

initial connection) go to step #8

7. Check Flow Cell alignment and check the focus go to step #11.2

go to step #11.3

8. Put 20 mL sample go to step #11.4

9. Turn on the bubbler  

10. Check the focus (in "Optic Configuration") go to step #11.3

3.2 Acquisition

1. Fill acquisition parameters (in "Fluidic Acquisition") go to step #11.7

2. Pump to drain sedimented organisms before acquisition (in "Optic Configuration")

3. Start the acquisition (in "Fluidic Acquisition")

3.3 Segmentation and data export 

1. Fill in segmentation parameters (in "Segmentation") go to step #12

2. Start segmentation 

3. Back-up data (in "Gallery" or by using FileZilla) go to step #13

4. Import on EcoTaxa go to step #15

Quick usage version

Quick usage version
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3.4 Cleaning go to step #14

1. Drain the syringe (disconnect your system)

2. Drain the content 

3. Replace with distilled water and drain several times (pushing with the syringe may

helps)

4. Replace the system and drain first with distilled water and then air

5. Empty waste tube

If not used immediately

1. Put 20 mL diluted bleach

2. Leave 15 minutes

3. Drain the content (high pump speed)

4. Put 10 mL distilled water

5. Drain the content (high pump speed)

3.5 Shut down

1. Turn off virtually (in "Home") and wait one minute

2. Unplug the PlanktoScope

4 To ensure the quality of your acquired data, you need to make sure that a certain number

of parameters are correctly entered, and you need to follow a non-exhaustive list of

good practices.

Make sure during the WB calibration that your mean green value is under 245

(overexposed otherwise) and over 220 (underexposed).

If you notice that your sample is over- or under-exposed, adjust your ISO value.

Make sure your Flow Cell is clean, inside AND outside.

Ensure that you do not see any side of the Flow Cell on the preview.

After each readjustment of the focus, acquire 2-3 images to check the quality of the

focus before starting the acquisition of your entire sample.

Take great care when filling in the metadata and do not forget to change the value of

the minimum acquisition size, which is 10 µm by default and which will determine the

segmentation. If you leave the default value (10 µm), you will end up with a large

number of very small objects that are totally blurred because they are not large

enough to be imaged correctly.

If you are working on a time series, note the sampling date in the station ID so that the

date is included in the name of the folder to be exported.

Quality Checks reminder
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Stir your sample well before transferring it to the PlanktoScope syringe and add the

bubbler directly after pouring in the sample to prevent the plankton from sedimenting

in the syringe.

Pump a small amount of sample before starting the acquisition to remove any

plankton that may have settled out, in order to avoid a bias in the abundance statistics

of your sample.

While the acquisition is in progress, stay in front of your instrument to make sure that

there are no organisms stuck in the Flow Cell or that you are pumping bubbles. This

will save you a lot of duplicate and imaged bubbles.

5 The PlanktoScope kit

In this part you will learn:

What is inside the PlanktoScope kit

How to connect the fluidic system with the Flow Cell

How to assemble the bubbler

How to put all the components together 

Open the PlanktoScope box and check that everything is in it. The PlanktoScope kit

includes a PalnktoScope, a bubbler, power cable, waste tube, sample tube, syringe,

tube holder, Flow Cell holder and Flow Cell (Fig.1; Fig.2; Fig.3).

Assemble the PlanktoScope
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Figure 1: The PlanktoScope Kit. (A) The main box with the pump (A1), the USB cover (A2),
the pi camera (A3) and the screws (A4); (B) Tube holder; (C) Bubbler; (D) Power cable; (E)
Flow Cell holder; (F) Supplementary materials box; (G) IFIXIT kit; (H) Flow Cells
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Figure 2: Material inside the box (F): (F1) 200 µm sieve; (F2) plastic dropper; (F3) cleaning
kit; (F4) fluidic system; (F5) SD card adaptor; (F6) syringe; (F7) waste tube; (F8) sample
tube; (F9) cleaning blower

protocols.io | https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4 February 28, 2025 10/81

https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4


Figure 3: Main components of the PlanktoScope (A in Fig.1)
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Safety information

If it is present, do not forget to remove the transparent cover from the camera (Fig.4). 

Figure 4: The transparent cover of the camera

5.1 The Flow Cell 

Safety information

The Flow Cell can break easily. Handle it with care. There is multiple Flow Cell in the
box to replace broken ones.

Do not touch it with your fingers or leave it on a surface. 
If a Flow Cell is dirty, you can clean it softly with the cleaning kit.  
The Flow Cell receptacle should be placed with caution on the lens to not break the
Flow Cell. 
Do not stretch the tubes attached to the Flow Cell, as this may damage the Flow Cell.
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1. Take a Flow Cell and plug the short part to the syringe with the help of a male adaptor

perpendicular to direction of the Flow Cell.

2. Install it like in the image on the left of the Fig.5 and press the tube where the arrows

point. Make sure it is perfectly flat (it will help for the focus later). 

3. Screw softly the two parts together. 

4. Add a velcro strap to hold the syringe in place.

5. Place the receptacle on the magnetic Flow Cell holder on the PlanktoScope. You can

put some tape on the magnetic parts to reduce the impact between the Flow Cell

holder and the receptacle.

Figure 5: How to install the Flow Cell. You will need the syringe (F6), the Flow Cell holder
(E) and one Flow Cell (H). 

5.2 The fluidic system

Now that you have fixed the Flow Cell, assemble all the fluidic system (Fig.6). Do not

forget to install the flux stopper on the matching tube (Fig.6). It will allow you to stop

the flow when it is necessary.
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Figure 6: How to assemble the fluidic system 

5.3 The bubbler 

A bubbler is needed to prevent sedimentation, as the PlanktoScope takes images of

fluids at low speed.

1. Assemble the bubbler like in the image below (Fig.7). It is recommended to use a cut

glass pipette or something similar instead of the needle provided because the

needle can be clogged and does not allow a good control on the air flux.

2. Plug the bubbler into one of the USB ports on the PlanktoScope. 

3. Place the tubing into the syringe so that it reaches the bottom. Do not put the tip of

the bubbler in the middle of the syringe or it will inject bubbles into the Flow Cell.

4. You can secure the tubing to the syringe using a rubber band, string or similar.

Safety information

Not agitating your sample will let plankton to sediment and could even block the
fluidic system. More importantly, the organisms concentration will be inhomogeneous,
and because you will first get the sinking plankton, will lead your measurements to
overestimate true concentrations.
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5. Switch on the bubbler: the flow of air in the water needs to be adjusted to

approximately 1 bubble/sec.

Figure 7: The bubbler

Note

Once the motor of the bubbler is connected to a tube, it should not be disconnected as
that can break the small piece of plastic that acts as an adaptor and make the bubbler
useless.

5.4 Assemble the PlanktoScope 

The fluidic system, the Flow Cell and the bubbler should be all assembled now.

Now you just need to place the waste tube in the outer hole of the tube holder and the

sample tube in the inner hole and plug the power cable (Fig.8).
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Figure 8: Assembled PlanktoScope

6 Initial connection

You can access to the user interface of the PlanktoScope by connecting to the Wi-Fi

generated by the PlanktoScope. Your computer will be only a projection of the

software of the PlanktoScope. It means that even if you are disconnected from the

Wi-Fi of the PlanktoScope, it will still be running.

1. Power your PlanktoScope by connecting the power cable to an appropriate electrical

outlet

2. Within 1 minute of turning on your PlanktoScope, you should see the LED flash once.

This means that the PlanktoScope is ready to be connected by Wi-Fi. 

3. You should see a new option for Wi-fi appearing on your computer. Connect to it with

the password: "copepode"

For more information and alternative methods of connection, see the designer's

Connectivity Tutorial here: PlanktoScope - Connectivity Tutori…   and

User Interface and initial connection
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PlanktoScope documentation for operating it here: https://docs-

beta.planktoscope.community/operation/#access-your-planktoscopes-software and

for networking here: https://docs-

edge.planktoscope.community/operation/networking/

Note

Note that when you are connected to the Wi-Fi of the PlanktoScope, you cannot access to
the internet. If you want to use internet at the same time, you should use your
smartphone's hotspot or an ethernet cable.

6.1 Download the software and flash the SD card

Download the latest release of the software on your computer here: 

https://github.com/PlanktoScope/PlanktoScope/releases

On this Github, you will find several SD card image files to download depending on

the different types of PlanktoScope hardware. To know which one is yours, go to

"Hardware settings".

If you need to update the software, or if there are a lot of bugs and you want to reset

it, follow this procedure: 

Once you download your SD image file, you have to flash it on the microSD card of

your PlanktoScope. For that you will need to install Raspberry Pi Imager

(https://www.raspberrypi.com/software/) and have a way to read the microSD card

on a computer. 

First you have to withdraw the micro SD card at the bottom of the PlanktoScope with a

fine forceps (Fig.1) and then connect the SD card to your computer with a SD card

adapter if needed (you can find one in the supplementary materials box).

Safety information

Before updating your PlanktoScope, save everything on an external drive or on your own
computer because the flashing of the SD card will delete all the data on the
PlanktoScope.
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On Raspberry Pi Imager (Fig.2): Press the "Choose Device" button and select "No

filtering" from the menu. 

Then press the "Choose OS" button, select "Use custom" from the menu and open

the PlanktoScope SD card image file you downloaded on the Github of the

PlanktoScope.

In the "Choose Storage" drop-down menu, select your SD card from the menu and

then press "Next".

In the pop-up dialog that appear asking if you would like to customize the OS, press

the "No" button unless you are already experienced with the PlanktoScope software.

Press the "Yes" button in the pop-up dialog that appear asking you to confirm

whether you selected the correct SD card and want to wipe all data on the SD card in

order to write the PlanktoScope SD card image to your SD card. 

The Raspberry Pi imager will start overwriting your SD card with the image from the

PlanktoScope SD card. This will take some time to complete.

Figure 1: How to withdraw the micro SD card
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Once flashing is complete, you can unplug the microSD card from the computer and put

it back in the PlanktoScope.

Figure 2: Raspberry Pi Imager interface

6.2 The User Interface (Node-RED dashboard, UI)

Open the PlanktoScope's User Interface (UI) on your web browser (Chrome, Firefox,

Edge etc.) using the following webpage link and go to the Node-RED dashboard

(Fig.1) (Fig.1):

http://planktoscope.local (this should work unless your  device and web browser are

without mDNS support; notably, older versions of Android do not have mDNS support)

http://pkscope.local (this should work unless your device and web browser are

without mDNS support; notably, older versions of Android do not have mDNS support)

http://home.pkscope (this should work unless your web browser is configured to

use a Private DNS provider)

http://192.168.4.1 (this should always work)

http://192.168.5.1 (this should work unless your web browser is configured to use a

Private DNS provider)
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On the home page you can also have access to links to documentation on

PlanktoScope, to the community or to further information for advanced users of the

PlanktoScope (Fig.2).

Figure 1: Node-RED dashboard page
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By clicking on "Note-RED dashboard" you will access the User Interface of your

PlanktoScope. 

There are several tabs on the User Interface (UI, Fig.3) that can be used to adjust

setting, run samples and take images. To navigate around the UI, all tabs are available

from the Home tab, including the Shutdown button. We can also use the Hamburger

Menu, situated in the top-left corner of the UI, to navigate between these tabs.

Figure 2: Links for the documentation, the community and for advanced users of the
PlanktoScope
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You will find:

the "Sample" tab to fill all the metadata of your sample

the "Optic Configuration" tab to control the various features of PlanktoScope (focus,

LED and pump)

the "Fluidic acquisition" tab to launch an acquisition and edit its parameters 

the "Segmentation" tab to start the segmentation of the images taken during

acquisition

the "Gallery" tab with files including the exports for EcoTaxa, the original images and

the extracted images

the "System Monitoring" tab to check the correct operation of the device (not use in

standard use)

the "WIFI" tab for the characteristics of the wifi generated by the PlanktoScope, to

which you will connect in order to control the device. You will not have to modify

anything on this page. 

the "Hardware Settings" tab (not needed for processing samples and strongly advised

to not change anything, except during calibration)

Figure 1: The "Home" tab of PlanktoScope's User Interface

Note

If all the tabs are not visible, you can adjust the zoom on your browser (usually Ctrl + scroll
UP or DOWN on Windows or command + scroll UP or DOWN on Mac).

6.3 The "Optic Configuration" tab

Once the UI has loaded on your browser, navigate to the "Optic Configuration" tab

and we will make sure the PlanktoScope is operating correctly (Fig.2). This tab can be
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used to adjust the camera settings. If only "Preview" is visible on your screen, the

other options should be available below by scrolling down.

Under "Optic Characterization", switch on the "Light" (Fig.3). You should see the

"Preview" image turning from dark to light. The Preview image could be any colour so

do not worry if yours show blue, red, green, etc. ; it will be adjusted later during the

White Balance (WB) calibration. You will need to switch on the light every time you

use your PlanktoScope.

Figure 2: The "Optic Configuration" tab 

Figure 3: The red box highlights the location for turning on the LED
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Under "Focus Adjustment" (Fig.4), click "UP 1MM" and "DOWN 1MM" to ensure

focus buttons turn the focus motor (same for the 100 UM version of the button). You

should see the frame moving further from (UP) or closer to (DOWN) the camera. You

can also use the ">>" button to move your focus according to a personalized

value ("Focus distance").

Under "Fluidic Manual Manipulation" (Fig.5), click clockwise arrow to check that the

peristaltic pump is working. You should see the pump rotating in an clockwise

direction. You can choose to pass a volume, but keep in mind that this parameter will

not impact the acquisition. On the other hand, the flowrate parameter will also be

effective during an acquisition.

Figure 4: Red boxes highlight "UP 1MM" and "DOWN 1MM" 
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Under "Camera Settings", you can see a button to change the ISO value (Fig.6). Set

the ISO to 150.  You should see your Preview image change colour when you adjust

this setting. The ISO is the light sensitivity of the camera. A low ISO will be less

sensitive to light and then darker. A low ISO tends to provide images of better quality.

Figure 5: The red square highlights the location of the clockwise arrow that will rotate
your peristaltic pump 

Figure 6: The red box highlights the location of the ISO setting
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Safety information

Keep the shutter speed at the minimal value. The shutter speed determine how long the
light will enter the camera to take one image. A low shutter speed provides better quality,
but it also requires the objects to not move too fast. 

7 Size calibration

Stay in the "Optic Configuration" tab. For this step, you will need the software ImageJ:

https://imagej.net/.

Note

To calibrate the PlanktoScope or if you just need to do a test, you can use the "Test" mode
in the "Sample" tab. It allows you to not fill the date or the location of the sample.

Safety information

Size calibration is an important process to get good data and should be absolutely done
and noted. It will allows to know the real size of the plankton.

7.1 Set up the scale

1. Remove the Flow Cell holder and tilt the PlanktoScope on the side with the camera on

the bottom (Fig.1)

2. Place a micrometric ruler (or a millimetric one) in front of the camera, at sample level,

such that the ruler is either vertical or horizontal but not in diagonal (Fig.1) 

3. Make the focus on the scale of the micrometric ruler (Fig.2)

Size calibration
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Figure 1: PlanktoScope on the side with the micrometric ruler

Figure 2: Focusing on the scale of the micrometric ruler

7.2 Take images of the scale
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1. Go in "Sample" tab and select Test as sampling gear (Fig.3).

2. Fill metadata (volume, depth and mesh size metadata are not relevant to fill for

calibration)

3. Take 1 or 2 images in "Fluidic Acquisition" tab (pumped volume does not matter,

Fig.4). You should only use acquired images to measure the real size of the pixels,

and not the preview image as it will give you wrong results.

Figure 3: Example of metadata entered in the "Sample" tab for the calibration

Figure 4: Here two images are acquired

7.3 Measure the number of pixels
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1. Download the images on a computer using FileZilla or the "Gallery" tab according to

your software version

2. Open ImageJ

3. Click on "File > Open" to open your image

4. Click on the line button (see Fig.5) and draw a line of known length by holding down

the click

5. Click on "Analyze > Measure"

6. Check the length value (in pixel)

In this example (Fig.5), the line is 3476 pixel length for 30 µm, which means that here

one pixel is 0.86, which differ from the expected value of 0.75 for this camera.

Figure 5: Line drawn using ImageJ on the picture taken with the PlanktoScope

7.4 Calculate the micron/pixel ratio

Calculate how much microns are represented by each pixel. The expected value for the

default camera is expected to be around 0.75. You will need to do 

Length(micron)/Length(pixels) (see the example in Fig.5).

7.5 Update the micron/pixel ratio

Enter the calibrated pixel size value in the "Hardware Settings" (Fig.6).
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Figure 6: Example of pixel size calibration settings

8 White Balance (WB) calibration

Stay in the "Optic Configuration" tab. For this step, you will also need the software

ImageJ: https://imagej.net/.

To check the WB, do not put the Flow Cell or anything between the camera and the

LED.

White Balance calibration
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Try pressing the Auto White Balance (AWB) button to its "on" and "off" positions on

the "Optic Configuration" tab; you will likely see the Preview image changing colour

(Fig.1). In this example (Fig.1), the correct setting was WB Red = 4 and WB Blue = 1.21.

The  AWB button should be set to "off" once you have completed this step.

The AWB feature is currently not optimised. In fact, not using AWB improves

PlanktoScope's performance over time because with the AWB, the camera will try to

adjust it in between every image. It is then recommended to manually adjust the

white balance of your PlanktoScope. Set the AWB button to "off". You will need to

adjust WB Red and WB Blue until it looks white/grey. The WB should never be perfect

white but grey, as it imply over-exposition during the segmentation step.

To manually set to the White Balance:

1. Remove the Flow Cell to avoid any biais

Safety information

PlanktoScope are normally cross-calibrated for white balance initially, this information
could be recovered from the provider. We strongly encourage you to note the initial
values before trying to change those and this procedure should not be done without
reasons (incorrect image with initial calibration; reboot or update of the software).

Note your initial calibration here:
WB Red: 
WB Blue: 

Figure 1: The red box highlights how to adjust the white balance of the Preview image
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2. Turn off the "Auto White Balance" button. Make sure the ISO value is 150. Never set it

to 0 or less, or it will create a bug in the software.

3. Take one image in the "Fluidic Acquisition" tab. You should not use the preview

image as it will not show the real colours taken by the camera.

4. Download the raw image in the "Gallery" tab or by using FileZilla.

5. Open the software ImageJ. 

6. Click on "File > open" and open your raw image.

7. Click on "Plugins > analyze > RGB". If you do not have the plugin or if it is not working

go to "Analyze > Histogram > Click on RGB" until you see the mean red, green and

blue values.

8. Once the values are extracted, calculate the ratio G/R and G/B like in the example

below.

9. Multiply it by the old ones to get the new ones.

10. Change the configuration and make sure the ISO value is still on 150.

Example:

If the default configuration is:

With this actual configuration, we measure the RGB (Red, Green, Blue) values:

The corrected WB Red or Blue is the ratio between the green value (G) on the

corresponding colour value (Red = R ; Blue = B) multiplied by the old configuration.

The new configuration should be:

WB ​ =red
old 1

WB ​ =blue
old 2

R = 245;G = 240;B = 230
G/R = 0.98
G/B = 1.04

WB ​ =red
new WB ​ ∗red

old G/R = 1 ∗ 0.98 = 0.98
WB ​ =blue

new WB ​ ∗blue
old G/B = 2 ∗ 1.04 = 2.08

Note

The green colour is a fixed value. It is then a way to check the exposure of your image.
Because the LED may slowly get aged, it is recommended to check the green value
with an acquisition and not with the preview. It should be in between 220 and 245. 

If the light exposure is too important (>245 in the green layer), put some tape on the
LED to decrease it, and do the WB calibration again.
If the light exposure is too low (<220 in green the layer), modify the ISO (or change the
LED; this latter may slowly dim with time)
Also, if the exposure is too important, it will be impossible to correct the WB.
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9 Pump calibration

Safety information

Peristaltic pump tubes flexibility varies with age, care and type of liquid used (e.g. lugol
may age it quicker), calibrating the pump regularly could be needed but is not highly
important to get good quantitative count since it is the number of images (therefore the
volume imaged) which is important (not the pumped volume).

9.1 Calculate pump step

1. Prepare a large volume of distilled water and put a total volume A of 20mL in the

syringe.

2. On the "Optic Configuration" tab: choose to pass a volume Y = 10 mL and record the

exact volume X it finally ends to pass (eg. by looking on the graduation B of the

syringe). X = final volume passed for a 10 mL instruction = A - B 

3. If the pump calibration is correct, X should be equal to Y = 10 mL

4. If it is not correct, update the pump step (see next step)

For example, in Fig.1: X = A - B = 20 - 15 = 5 mL. There is then an error in the calibration

and we need to update the pump step according to this error.

Figure 1: Volume pumped

Pump calibration
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9.2 Update pump step

1. Go to the "Hardware Settings" tab (Fig.2)

2. Note the initial calibration “Pump: step per mL” here: 

3. Calculate the calibrated "Pump: step per mL" such as New Step = (Y/ X)*old step

4. Replace the “Pump: step per mL” parameter in "Hardware Settings" with the value

calculated in the previous step

Figure 2: Example of Hardware Settings 

10 This protocol considers that a plankton net is used to collect the sample. 

In this section, you will:

1. Collect your sample 

2. Fill a log sheet

3. Filter your sample with a 200 µm sieve

10.1 Collect your sample and the metadata

Get your sample
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You can find here a logsheet example (based on the data needed in the "Sample" tab).

Operator: 

Station ID: 

Sampling gear: 

Process time: 

Net throw Lat: 

Net throw Lon: 

Net throw date/time: 

If it's an horizontal sampling:

Net retrieval Lat: 

Net retrieval Lon: 

Net retrieval date/time: 

Minimal fraction (μm): 

Maximal fraction (μm): 

Min depth (m): 

Max depth (m): 

/!\ Critical information

Filtered Volume (L): 

Concentrated sample volume (mL): 

Dilution factor (<1 if there has been a dilution): 

Net opening dimension (mm): 

Speed Through Water (kts): 

Safety information

Using logsheets:
-Record Latitude Longitude (taking photos of the GPS when launching and recovering the
net could serve, if UTC time is on the GPS this could also be interesting)
-if vertical net, record min and max depth
-if horizontal records initial/final positions, speed and length (min) of deployment
-if you have flowmeter, record the initial/final digits of the flowmeter and calculate the
filtered volume

in all cases the diameter of the net opening will be needed

Those are critical information to get to quantitative sampling.

10.2 Filter your sample
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Safety information

Larger organisms may clog the Flow Cell. It is then necessary to filter the volume
through a 200 µm sieve. Rinse the sieve using seawater and a squeezing wash bottle
(helps to pass small objects).

Figure 1: How to filter the sample with the 200 µm sieve

11 Assemble and start the PlanktoScope before (see go to step #5  )

In this section you will:

1. Fill the metadata of the logsheet in the "Sample" tab

2. Check the focus and the Flow Cell 

3. Switch on the light and the bubbler

Pass the sample on PlanktoScope
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4. Put your sample and check the concentration of it 

5. Dilute your sample if necessary 

6. Pass sedimented organisms

7. Launch an acquisition

11.1 Fill the metadata

Go to the "Sample" tab and fill in the metadata. This step is critical because those

data are the ones that will make your sample usable or not.

Fill the sample identification (project, name, ship used, your name and the station

number; Fig.1)

Safety information

If the PlanktoScope has already been used before, the old metadata are kept. It can be
useful, but do not forget to change them if it is necessary.

Figure 1: Sample ID parameters

Safety information

Station ID is the name of your sample (and will be converted into "sample_id" in EcoTaxa),
so put here all information needed to identify your sample (Acquisition ID is a false
friend  and may lead to strange results depending on analytical pipeline; it could not be
used as a filter in EcoTaxa).
If working on a time-serie, date should be present (DO NOT USE "/" characters).
If working on replicates, replicate number should be present.
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Select the "Sampling gear" used during the sampling. Use preferentially "Plankton

net" for all types of samplings. You can also use "Single location" for vertical

sampling but it won't compute the filtered volume automatically.

Note the mesh size of the net used for sampling in "Minimal fraction size". It will be

used afterwards in the segmentation process, object smaller than this will not be

segmented.

The "Maximal fraction size " is the mesh size of the sieve used to filter the sample

during preparation. It must have been done at 200 µm to not clogged the fluidic

system.

Note the "Min sampling depth" and "Max sampling depth" of your net. 

The "Filtered volume" is the total volume passed through the net during sampling. It

is better if you recorded it but could be calculated from other parameters. So, make

sure to either have filled it or to have filled either min and max depth if using a vertical

net; initial/final positions, speed and length (min) of deployment if using an horizontal

towed net; and in all cases the diameter of the net opening (to be able to calculate the

volume afterwards). For vertical samplings, it can also be computed by hand easily

with a formula (see below).

"Concentrated sample volume" is the final volume recovered from the net after

dilution/concentration (Fig.2).

If a dilution has been done, note the “dilution factor” (if not, write "1"). <1 if it is

diluted and >1 if it has been concentrated. 

Note

Filtered volume for vertical samplings : 

Vfiltered = (π × rfilet)
2 × Δh

'rfilet' = Radius of the net opening (meters).

'Δh' = Difference between sampling depth (meters).
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Fill the net initial and final position (if towed horizontally) remember to validate both of

them (Fig.3). Note that the Latitude and Longitude values should be written in decimal

(only degree) or in sexagesimal (degree, minute) format. 

Figure 2: Example of sampling parameters

Note

Known bug: If filtered volume is provided but also initial/final latitude and longitude,
calculation from this latter may replace the measured filtered volume.
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Figure 3: Example of date and time of the sample

11.2 Check Flow Cell alignment

1. Turn on the light 

2. Check for lens alignment with the Flow Cell. Move slowly the Flow Cell receptacle

until there is no black background like in Fig.4.
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Figure 4: The figure on the left shows a misaligned Flow Cell. The background should be
homogeneous like in the figure on the right.

11.3 Do the focus 
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Go to the "Optic Configuration" tab:

1. Switch on the light if you have not already done so

2. Check focus on the two sides of the Flow Cell, and try to have a focus between the

two sides (Fig.5). In the Fig.6, you can see on a dry Flow Cell that has been exposed

to water, there are still water droplets on both sides. Use them as an indicator to do

the focus. 

Figure 5: Focus zone of the Flow Cell
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On Fig.6, there is a good focus on the front, and you can see two more poorly focused

water droplets on the back. The focused bubbles are on one side of the Flow Cell,

which means you can now count the number of clicks it takes to get the bubbles in

the back well focused. Multiplying the number of clicks by the distance of the button

chosen to go from one side to the other gives the actual distance of the Flow Cell.

Then divide this distance by two, enter the value in "Focus distance (µm)" and use the

double arrows to focus in the middle of the 2 sides of the Flow Cell.

This step also allows you to check that your Flow Cell is properly levelled. If bubbles

in the same layer do not all have the same focus, your Flow Cell is not straight. You

are going to have to reposition it by taking it out of its holder, so it is important to

Figure 6: Water droplets

Note

tip#1: start using the "1 MM" buttons, then the 100 µm buttons and finish by typing 25
or 50 µm adjustments in the middle box and pressing external arrows of focus; 
tip#2: you can connect your phone or a tablet to the PlanktoScope to have controls on
the focus while checking a zoomed portion on the streamed image on another device.
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check this before putting your sample in the PlanktoScope. Be very careful not to

break the Flow Cell.

11.4 Put your sample in the PlanktoScope

1. Close the flux stopper

2. Fill the sample in the syringe. For this you can just remove the full sample holder and

fill it on top of a sink (to not risk spills on top of the PlanktoScope; Fig.7)

3. Reconnect the syringe to the pump

4. Open the flux stopper

5. Place the bubbler and adjust the flow to 1 bubble/second

Safety information

Never forget to open the flux stopper. If the flux stopper is closed for a long time, it
can deteriorate the fluidic system.

Safety information

Not agitating your sample will let plankton sediment and could even block the fluidic
system. More importantly, the organisms concentration will be inhomogeneous, and
because you will first get the sinking plankton, will lead your measurements to over-
estimate true concentrations. You should agitate your sample using bubbling and use
a sufficient pumping rate to avoid sinking/clogging of sample.

protocols.io | https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4 February 28, 2025 44/81

https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4


Figure 7: How to remove the part of the fluidic system containing the Flow Cell to fill
the syringe with water

11.5 Dilute your sample if necessary

Adjust the concentration of the sample: ideally not more than 20-30 objects should

be present per frame. If the sample is over-concentrated, dilute it by a factor 2 (add in

a jar 1/2 of the sample -after agitating it- and 1/2 of seawater). Note the dilution

factor in the metadata !

Safety information

Having too many objects per frame will:
increase the probability to aggregate objects (making them impossible to count or
identify)
increase the probability of clogging the fluidic system
create artefacts during the segmentation step 

11.6 Pump sedimented particles

In the "Optic Configuration" tab, pump with high flow rate a good amount of water to

remove plankton that have sunk in the fluidic system. You do not need to pump a

large amount of your sample, 1 mL is sufficient (Fig.8).
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If your fluidic system is not optimised to avoid plankton sedimentation, some plankton

could accumulate in the fluidic system. This can be checked by pinching the tube

halfway in between the Flow Cell and the pump during 1-2 seconds (to accumulate

suction pressure) and releasing it (Fig.9). If a large quantity of plankton passes

suddenly this means that plankton have sedimented between the syringe and the

Flow Cell.

Figure 8: How to pump a specific volume without image acquisition. 

Safety information

Be careful, even if the volume chosen here will not impact the future acquisition (it is
completely independent), the flowrate will be the one used during the acquisition. It is
recommended to have a low flowrate for an acquisition (around 2 mL/min). Do not change
the flowrate during an acquisition and stay around 2 mL/min after you pumped
sedimented organisms. 

Safety information

v.2024
Known bug: Do not enter a decimal number as a flowrate or it will not save the metadata
properly ! 
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Figure 9: How to unclog the fluidic system

11.7 Acquisition

Go to "Fluidic Acquisition" and set parameters (Fig.11).

"Number of images to acquire": Target a sample size that will give you something

like 1000-2000 final objects or more (e.g. if you have 10 objects per image, imaging

100-200 frames would be enough; Fig.10). Lower numbers of objects would be

statistically problematic. 
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"Pumped volume" is the volume to pump in between two images. It should be large

enough to: avoid taking twice the same object in picture, avoid large sedimentation in

the fluidic system and avoid objects to stick on the Flow Cell. It is recommended to

put it at 0.03 or 0.01 mL.

"Delay to stabilise image" is the time lag in between the stop of the pump and the

acquisition of the image. It should be large enough to avoid objects moving while

imaged.

Figure 10: Number of species per number of images acquired for a random sample. Note
that the number of species starts to stabilise around 2000 images here. 

Safety information

Pump significantly between two images will help to:
Avoid plankton sedimentation in the fluidic system
Avoid imaging two times the same plankton
Avoid organisms to stick on the Flow Cell
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1. Go to "Fluidic Acquisition" and take two or three images to check if the focus is good.

If it is not, try to do it again directly on the plankton.

2. Change the acquisition ID, the old one is used by the focus test

3. Make sure that the "Total pumped volume" is less than the volume in your syringe

to avoid pumping air.  If not, you can reduce the number of images to acquire or the

pumped volume if needed.

4. Launch the real acquisition

5. Wait for the acquisition to be done

6. Results can be consulted by consulting the "Gallery" tab 

Figure 11: Acquisition parameters. This figure is not a recommendation, as it depends on
the number of objects you want to acquire and the type of Flow Cell you use. 
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Safety information

The PlanktoScope is using a rolling shutter camera which means that there is a small
delay in between the first line of pixel imaged and the last line of pixel imaged. To
overcome this, it uses a "stop and go" strategy where the imaging only takes place
when the flow of the pump is stopped. Not setting this properly will generate artefacts,
swimming organisms will also suffer from this (Fig.12).

Figure 12: Copepod nauplii moving while imaged

12 Segmentation

1. Go on segmentation and click on the "Update acquisition's folder list"

2. Select the samples you wish to segment, either the parent folder or the file itself 

3. Setup the different options of the segmenter (Fig.1)

Segment the acquisition
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Recursive folder: it will segment all acquisition within a selected sample

EcoTaxa archive: it will create a zip file containing all files needed for a easy

importation within EcoTaxa

Force rework: if yes it will re-segment samples already segmented

Keep objects: it will keep the final segmented images visible in the PlanktoScope. It

could be accessed by the "Gallery" in the "objects" folder

1. Scroll down and click on start segmentation

2. Wait for the segmenter status to turn to "Done" (Fig.2)

3. Export your data on your computer

Safety information

Even if the segmentation process can take a lot of time, it is not recommended to start
the acquisition of a new sample during this part in case the results are corrupted. You
should do the cleaning of the fluidic system and process a new sample only if you are
sure that all your images are not corrupted.

Figure 1: Where to find the folders containing the images to do the segmentation. Do not
forget to update the folder list.

Figure 2: End of the segmentation
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13
There are two ways to export data from the PlanktoScope to your computer. One is

directly from the "Gallery" tab in the User Interface and the other one is with FileZilla.

13.1 With the "Gallery"

Go to the "Gallery" tab (Fig.1):

For raw images: img 

For segmented images used in EcoTaxa: export > ecotaxa

For detailed process: clean

For segmented images without metadata: objects

Select the different files you do want to save and use the "download" button (Fig.2)

Figure 1: User interface of the "Gallery" tab

Figure 2: How to download your .zip file for EcoTaxa

How to export data
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Note the presence of a delete button close by. It is useful to purge the memory of the

PlanktoScope. The "clean" and "object" folder could/should be purged regularly (Fig.3).

However, the "img" and "export" files should be kept with caution. In the "export" folder

are your final results and in the "img" folder are your base results that are sometime used

to re-segment the final vignettes.

Figure 3: How to delete everything in the "clean" folder

13.2
With FileZilla

You will need a computer connected to the PlanktoScope together with the free

software FileZilla (https://filezilla-project.org/).

1. Open FileZilla

2. Either click on the top left to create a new connection or use the quick-connection

fields below (it will not save the ftp site for later, Fig.4)

3. To create a new connection "file > site manager > new site"

Enter the following information: 

Host: sftp://192.168.4.1 

Username: pi

Password: copepode

Port: 22
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1. Click on "Quickconnect".

2. On the bottom panels you have on the left, the access to what is in your computer,

and on the right, the access to what is in the PlanktoScope (Fig.5). Click and slide to

transfer data in between both.

Exports file for EcoTaxa  are in /home/pi/data/export/ecotaxa.

Raw images files are in /home/pi/data/img.

Different control files to check the segmentation process (images after background

subtraction, masks of the different objects etc) are in /home/pi/data/clean.

Final images are in /home/pi/data/objects.

Figure 4: How to log to a ftp host

Figure 5: Interface of FileZilla. Personal files are on the left, files of the ftp host are on the
right

14 Cleaning

1. Drain the sample out of the syringe

Clean the PlanktoScope
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2. Disconnect the syringe and clean it with distilled water 

3. Pump (at high speed !) the full content of the fluidic system to remove any liquid

4. Reconnect the syringe

5. Fill it with distilled water

6. Pump (at high speed !) while regularly pinch the tubing to detach any plankton in the

system (see go to step #11.6  )

7. Drain again the syringe (repeat steps 2 to 7 at least 2 more times until no plankton is

visible on the camera)

8. Finally drain the system

If not used again immediately afterwards 

1. Put 20 mL diluted bleach

2. Leave 15 minutes

3. Drain the content (high pump speed)

4. Put 10 mL distilled water

5. Drain the content (high pump speed)

6. If there are traces of calcification, use a diluted acid solution (like HCl diluted by 6).

15 In this section you will learn to:

1. Do your first connection on EcoTaxa

2. Create a new project 

3. Connect to EcoTaxa with FileZilla

4. Import data of the PlanktoScope to EcoTaxa

First connection

Create an account on EcoTaxa (https://ecotaxa.obs-vlfr.fr/) by clicking on the top

right "Log in/Register" then on "Create your EcoTaxa account" (Fig.1).

Upload your images on EcoTaxa
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Put your real name and a valid mail so that you can be contacted (Fig.2)

Figure 1: Log in/Register interface

Figure 2: EcoTaxa account creation interface

15.1 Projects
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Once logged in, you can consult the project on which you are registered (e.g. your

own projects and the ones you have been invited by the different data owners) by

clicking on "Contribute to a project" on the main page (Fig.3).

Figure 3: Accessible buttons on the home page

15.2 Create a project

Go to "Contribute to a project > Create a new project". You can create your own

project on which you will be able to import, visualise and classify images.

In the creation panel, you can (Fig.4):

Add the title of your project

Describe your project

Comment your project

Define the instrument used (here, the PlanktoScope)

Choose if you want to annotate (define taxonomy) or only explore images, etc. and

who can see your project

Define what pre-trained Deep Learning features to use on your project (it is

recommended to use «Planktoscope_2022-09  » unless you see a more recently

trained model on PlanktoScope image)

Choose a license for your images (it is recommended to use one of the CC-BY one or

CC-0 if you want data to have a future use for science)

Define a list of taxa to help you classify your sample (in the "Taxonomy" tab)

Add useful sorting variables in "Sorting Tools" that will be added to the top bar filters:

area=area

meanhue=meanhue

meansaturation=meansaturation

meanvalue=meanvalue

Invite new contributors/viewer/manager and add a contact for the project.
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If you want to edit the settings later, go to "Edit project settings" (Fig.4).

Figure 4: New project interface

Figure 5: "Edit project settings" button

15.3 Connect to EcoTaxa ftp
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Upload the EcoTaxa archives (see step 6-7) on the EcoTaxa ftp

Select File > Site Manager...

Create a New Site called: Ecotaxa_VLFR

In General tag:

Host: plankton.obs-vlfr.fr

Protocol: FTP – File Transfer Protocol

Encryption: Only use plain FTP (insecure)

Logon Type: Normal

User: ftp_plankton

Password: Pl@nkt0n4Ecotaxa

Once this is done you could use FileZilla to load the Zip files downloaded from the

PlanktoScope onto the EcoTaxa ftp server (e.g.

/Ecotaxa_Data_to_import/PLANKTOSCOPE).

Safety information

You can also download the zip file directly from your computer, without using FileZilla.
Otherwise, FileZilla is recommended for huge amounts of data.

Safety information

Please eventually create your own folder to try to keep it clean and tidy.
Please think to regularly remove those temporary files from the ftp, at this point they
are not secured at all and everybody can access them (and disk space is not free).

15.4 Import data in your project

1. In your project: on your "Project" options button, select "Import images and

metadata" (Fig.6)

2. Locate your file on the EcoTaxa ftp folders and import it or upload your zip file directly

(only works for one zip file at a time; Fig.7)

3. Check the quality of your images and the quality of the segmentation once the images

are imported
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Figure 6: How to import images and metadata

Figure 7: Data import interface

16 In this section, you will learn to:

1. Use filters

How to use efficiently EcoTaxa
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2. Validate taxonomy

3. Do a prediction

4. Export the results

Note

For more details, please check the online manuals 
https://sites.google.com/view/piqv/piqv-manuals/ecotaxaecopart-manuals?authuser=0

16.1 Use filters wisely

There are three layers of filters in EcoTaxa (Fig.1): 

The taxonomic filter tab that allows to filter by taxonomic groups either from the list of

taxa that you defined when creating the project (they will be underlined in the

suggestions when you start typing) or from alll the taxonomic categories registered

on EcoTaxa (Fig.1(A)).

The other filter tabs allows you to filter by sample and by all the parameters of the

samples (depth, location, time, annotator, and all the information entered in your

metadata; Fig.1(B)).

The top bar is for the status and features filters (Fig.1(C)). They are very useful

because they allow you to sort objects according to descriptive values specific to

each image (eg. mean saturation in Fig.3, to quickly observe objects that have lots of

chlorophyll). You can revert the sorting order of those filters by ascending or

descending order. You can also choose to display images according to their status

(validated, predicted, dubious, etc) as well as the number of images you want to see

per page.
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Filters are additive (Fig.2), so you can add filters on location, date, annotator,

taxonomic group and every metadata fields entered in EcoTaxa to search for specific

things. You can also get rid of them easily by clicking on the cross in the grey fields

that you can see at the top of the Fig.2. 

Figure 1: (A) Taxonomy filters; (B) Sample filters; (C) Status and feature filters
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Figure 2: Multiple filters applied in a project. At the top of the figure you can see that the
filters allows to see only the taxon "Rotifera" of a specific size (area of the image), at a
specific time and location.

Figure 3: Objects sorted by the mean saturation

16.2 Similarity search

On the top-right corner of each objects, there is a clickable target highlighting "Search

similar objects" (Fig.4(A)). 
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Once clicked, this tool will search, among the active filters of the project, the objects with

the highest similarity compared to the selected object and order them. If no filters are

selected, it will therefore work on the whole project. This similarity filter will now appears

in the "status and feature filters" and can be reused during working session but will

disappear once you exit the project (Fig. 4(B)). 

Figure 4: (A) Before similarity search; (B) After similarity search

16.3 The different validation status in EcoTaxa and how to validate

Image imported in EcoTaxa have the status "Unclassified" (grey surrounding of the

image, Fig.5).
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However they could be also set as "Predicted" (blue surrounding; classified

automatically by taking as example one pre-existing project), "Validated" (green

surrounding; checked and annotated by a human), or "Dubious" (orange surrounding;

checked and annotated as dubious by a human) (Fig.6).

You can validate an image either by dragging it into a taxonomy filter among the taxa

defined in the preset (Fig.7), or by typing the name of the taxa directly into the search

bar of the "Taxonomy filter" tab (Fig.8). Once validated the name appears in red

below the images and they appear surrounded by green (Fig.9). For the validation to

be taken into account, it is important to always save either with ctrl + S or with the

"Save pending changes" button at the bottom of the page (Fig.10).

Figure 5: Unclassified images

Figure 6: Types of images status: blue predicted, green validated, orange classified as
dubious and grey unclassified
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Figure 7: Dragging image to validate

Figure 8: Typing in the search bar of the "Taxonomy filter" tab to validate

Figure 9: Image configuration after validation

protocols.io | https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4 February 28, 2025 66/81

https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4


When you have a lot of images and/or are dealing with unfamiliar taxonomic categories,

the validation process can take a lot of time and energy. To speed up this process, you

can use prediction tools. They allow you to validate thousands of images with a single

click (Fig.11).

Figure 10: Do not forget to save your validations

Figure 11: Example of well predicted objects which would be easily validated

16.4 Prediction 

Once you have validated at least 20 images per taxonomic category, you can use the

prediction tools to speed up the validation process. To predict the images of your taxa

in the taxonomy filter, you can use your own project or another pre-existing

PlanktoScope project, preferably in the same location and with similar plankton

community as a reference (Fig.13). You can run a prediction directly after importing

your images with another project as reference, but be aware that the quality of the

prediction will not be ideal. The more images you validate, the more reliable the

prediction will be. 20 images is the smallest number of validations per taxonomic
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category necessary to ensure the quality of the prediction if you are using your own

project as a reference.

In "Project" (or "Filtered", if only the filtered images need to be predicted), select

"Train and Predict classifications" (Fig.12).

Launching a prediction directly after importing the images into EcoTaxa will allow you to

quickly validate around twenty images on your own project. However, until you have

validated the images, you should use a pre-existing project as a reference for the

prediction (Fig.13). Note that currently, only few PlanktoScope projects acquired with the

same segmentation procedure than we do exist, we therefore strongly encourage you

after a first trial of prediction to quickly validate to then predict on your own project.

Projects that could be used for first prediction: 

#6818 - MOOSE-GE-2022_tests_ID_vignettes (Med sea; Processed with current

segmenter; Fully validated) https://ecotaxa.obs-vlfr.fr/prj/6818

Safety information

You can use the PlanktoScope machine learning algorithm in your project. Go to
Project > Edit project settings and chose the SCN Network "planktoscope_2022-09". Do
not forget to save changes.

Figure 12: Click on the button "Train and Predict classifications" to start a prediction
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#9621 - APERO_PP&THA_Phytonet_35mu_Planktoscope https://ecotaxa.obs-

vlfr.fr/prj/9621

#10 056 - AtlantECO_P2_Ada_2023 (PlanktoScope; Fully validated) 

https://ecotaxa.obs-vlfr.fr/prj/10056

#6765 - Planktoscope Reference (Processed with other segmenter, works only with

adding Deep Learning features into play); Fully validated) https://ecotaxa.obs-

vlfr.fr/prj/6765

Click on "Next: Choose objects in selected projects". You then have the possibility to

select what types and quantity of objects to consider. It is recommended to avoid

selecting too many objects in a category, in  order to partially correct the usual strong

imbalance between categories (Fig.14, limited to 500 objects per group).

Click on "Next: Choose features in selected objects" to activate the pre-trained deep

learning features (if not available see step 10). You can uncheck variables that are not

relevant for prediction and relate to position of the vignette in the initial images such

as bx, by, depth min/max, label, local centroid col/row, x, y (Fig.15).

Figure 13: Prediction learning sets

Figure 14: Choice of objects to train the machine learning algorithm

protocols.io | https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4 February 28, 2025 69/81

https://ecotaxa.obs-vlfr.fr/prj/9621
https://ecotaxa.obs-vlfr.fr/prj/9621
https://ecotaxa.obs-vlfr.fr/prj/10056
https://ecotaxa.obs-vlfr.fr/prj/6765
https://ecotaxa.obs-vlfr.fr/prj/6765
https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4


Click on "Start prediction task". Once done, images have the status "Predicted". Each

image has a "Score" that represent the reliability of the prediction (Fig.16). It is

therefore a good filter to use when you want to validate a large number of images

quickly to then launch a prediction with your own project. Do not hesitate to launch a

prediction as soon as you have validated most of the images with a high score.

Figure 15: Prediction features and settings

Figure 16: Example of images sorted by score of prediction
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Keep validating and making predictions until your project is fully validated.

Safety information

Making repeated predictions on your own project is always better than doing so on pre-
existing random projects.

16.5 Export your results from EcoTaxa

Once fully validated, export your results (Fig.17). Different solutions exist, general export

for configurable objects export (Fig.18), back up export for restoring or archiving and

summary export for synthetic taxon-oriented export (Fig.19).

A general export will give you all the metadata of your project. You can chose to

separate (in ZIP sub-directories) output by sample, acquisition, taxon or to not

separate the output. We recommend to chose to separate by sample (Fig.18).

Figure 17: How to export data

protocols.io | https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4 February 28, 2025 71/81

https://dx.doi.org/10.17504/protocols.io.bp2l6bq3zgqe/v4


With the summary export, you will not see all the metadata and thus the potential

errors lying in it. It is very important to check for errors and what is missing from the

metadata to ensure that we have a full quantitative signal and not just a relative

abundance signal. This type of export allow you to chose what you want to compute,

either the abundance, the concentration or the biovolume (Fig.19). Depending on what

you choose as the to compute parameter, you need to enter a specific formula to

extract them. For the abundance, this is "just" counts of vignettes, you do not need

everything. For the concentration and the biovolume it depends a lot on the method

you used to sampled and on the metadata. 

Copy/Paste this command in the "Formulae" tab of the summary export to extract

PlanktoScope data: 

With: 

Figure 18: General export interface

Command

subsample_coeff: 
sam.concentrated_sample_volume(sam.total_volume*ssm.imaged_volume* 
sam.dilution_factor)
total_water_volume: sam.total_volume/1000/1000
individual_volume: 4.0/3.0*math.pi*
(math.sqrt(obj.area/math.pi)*ssm.pixel)**3
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Concentration:

subsample_coeff:

sam.concentrated_sample_volume/(sam.total_volume*ssm.imaged_volume*

sam.dilution_factor)

total_water_volume: sam.total_volume/1000/1000 (%from mL to m3)

Biovolume in plain area:

individual_volume: 4.0/3.0*math.pi*(math.sqrt(obj.area/math.pi)*ssm.pixel)**3

and with:

sam: sample part of the data

ssm: process and acquisition part of the data

Safety information

These formula only work when all volume have the same units: either mL everywhere or 

m3 everywhere.

Figure 19: Summary export interface

Safety information

Before starting the data analysis, it is very important to check for errors and what is
missing from the metadata to ensure that we have a full quantitative signal and not just a
relative abundance signal. 
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17 Calibrate your data

EcoTaxa generate a lot of interesting variables to analyse your sample. Only a few of

them are depicted here, but do not hesitate to explore the other ones. 

Before any analysis, it is important to relate all the parameters computed by

EcoTaxa with the acquisition parameters. You will need:

It will allow you to compute the conversion factor "conver". The dilution factor should

be < 1 if a dilution has been made and > 1 if the sample has been concentrated (it is

not the sample concentrated volume, which is the original volume taken from the

collector):

Compute Biovolume

There is three methods to calculate the biovolume (BV) of an object.  

Ellipsoid:

Table 1: Transformations to apply to essential variables. 

conver = ​

V ​∗V ​∗Dilutionimaged total

V ​concentrated

Safety information

Do not forget to convert all the parameters like above. Otherwise, it will produce wrong
results.

AR = π ∗ ​ ∗2
major

​2
minor

How to compute biovolumes
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Plain:

Riddled:

BV = ​ ∗3
4

​ ∗2
minor AR

ESD = 2 ∗ ​​

π
area

R =3 ( ​)2
ESD 3

BV = ​ ∗3
4 π ∗ R3

ESD = 2 ∗ ​​

π

area_exc

R3 = ( ​)2
ESD 3
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18 Clean tubing and Flow Cell from inside

Imaging plankton will lead to have a lot of organic material and seawater in the fluidic

system. Some may clog or accumulates in some parts of the fluidic system.

1. Do not let it dry and try to get rid of it as soon as possible. If it occurs during sample

acquisition, abort it, take care of the clog. You may need to dilute the sample, note the

dilution in the metadata and restart acquisition.

2. Pump distilled water with high pumping rates helps to unclog the system. Make sure

no plankton organisms remain in the fluidic system and especially on the internal

walls of the Flow Cell. If it is the case do not hesitate to pinch (during 1-2 second) and

release the tubing between the Flow Cell and the pump while pumping to create a

sudden variation of pressure.

3. Over time, wet conditions and organic matter may create favourable condition for the

growth of a bacterial film. The Flow Cell and tubing will look dirty from the inside. You

can avoid this by pumping diluted bleach, let it in for 1-2 hours and carefully rinse the

whole system.

4. Water, bacteria, and bleach together may favour the apparition of a calcium carbonate

film inside the tubing and Flow Cell. It may either appear as dispersed crystals

attached inside the Flow Cell or a white coating inside the tubing. To remove and

clean this, pump some acidic solution (vinegar, citrus juice or other kind of other

acids), let it rest for a few hours and rinse the system.

Clean Flow Cell outside:

The Flow Cell is an optical critical component, keeping it clean is an absolute necessity.

Do not touch it with fingers or other kind of dirty material. If dirty:

Maintenance of your PlanktoScope
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1. If only dry dusts are present, gently blow the Flow Cell with the cleaning blower.

2. If the dirt is not only dry dusts it could be cleaned with optical paper and ethanol. 

DO NOT USE CLASSICAL PAPER TOWELS! 

They are usually enriched in silica fibres for solidity and may create scratches on the

Flow Cell. If optical paper is not available, paper tissues are a better alternative.

Clean optical lenses

As for the Flow Cell, optical lenses are critical elements of your PlanktoScope and should

be kept as clean as possible. It starts by never touching them with fingers ! Cleaning

those would require a lot of patience, efforts and may even lead to unexpected

disappointments.

1. Dry dust: dry gas with even more caution than previously.

2. Others: only used optical paper.

Clean the camera sensor

Critical part ! NEVER touch it, only use dry gas.

Regularly calibrate the pump and the WB.

19 The Flow Cell is clogged with plankton

Why this happens: 

First this may happen if your sample does not have been pre-filtered. It is

recommended to do a pre-filtration to 200 µm. 

It may also happen if your sample is too concentrated. If you got more than 20

plankton objects per image this may already be the case, dilute your sample and fill

the dilution factor in the sample metadata.

If you forget to use a bubbler to agitate your sample, or if you let your sample

stagnate too long in the fluidic system.

Unclogging the Flow Cell:

Try to pinch the tube in between the Flow Cell and the pump while the pump is

running. 

Try to do the same while pumping in the reverse direction eventually at high speed.

Dismount the Flow Cell but keeping the tube adapter on it. On the side which was

connected with the pump, connect a syringe and pass air/water to chase the blocked

plankton.

19.1 The image is partly blurred

Troubleshooting
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Why this happens:

The focus is correctly done, but the Flow Cell is not well positioned.

How to correct it:

Try to adjust the position of the Flow Cell by tightening the Flow Cell holder using the

screws (Fig.1). 

Sometimes, even after repositioning the Flow Cell in the designated notches on the Flow

Cell holder and tightening it with the screws, it still does not lie flat and part of the image

is still blurred. This may be due to a defect in the Flow Cell holder, in which case you can

place pieces of tape over the notches (Fig.2). This will ensure that the Flow Cell lies flat. 

As always, handle the Flow Cell with great care to avoid breaking it.

Figure 1: On the left, a Flow Cell correctly positioned. On the right, the Flow Cell do not fit
correctly between the fixations of the Flow Cell holder, creating a blurred gradient.
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Figure 2: How to tape the notches of the Flow Cell holder

19.2 The software is not working

Why this happens:

The python code encountered a bug. 

There is a segmentation error because the number of objects is too important.

The optical configuration tab does not work (black screen, impossible to change the

WB, etc...).

Solutions:

Try to restart the PlanktoScope.

Try to change values of the WB, check if you use commas or dots and restart the

PlanktoScope.

Try to stand by a number of final objects around 2000~3000 per sample.

Ask questions on the PlanktoScope Slack (see "External links" section).

If you do not find any solution, flash the SD card of the PlanktoScope with the

software by using BalenaEtcher. go to step #6.1
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Safety information

Before flashing your PlanktoScope, save everything on an external drive or on your own
computer because the flashing of the SD card will delete all the data on the
PlanktoScope.

19.3 The pump is not working

If there is any problem with the pump, check that it is properly positioned (Fig.2). If it

is not the problem, remove it and check that the pump tube is correctly positioned.

1. If you need to change the internal pump tube, you can take the pump off by turning it

counter-clockwise. 

2. Position the tube correctly

3. To install it again, place it in the position shown in the image below until it clips, push it

in and turn it clockwise until it snaps into the white socket (Fig.3). 

4. Be careful to clean the grease afterwards
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Figure 2: How the tube should be installed inside the pump

Figure 3: How to install the pump
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20 PlanktoScope website

https://www.planktoscope.org/

PlanktoScope github

https://github.com/PlanktonPlanet/PlanktoScope

PlanktoScope complete assembly guide and complete documentations

https://planktoscope.curious.bio/ (v2.5)

PlanktoScope Slack channel (to exchange ideas/protocols/solutions/questions)

https://forms.gle/qvh5jwuMvmyBKMQC7

Plankton Planet website

https://planktonplanet.org/

EcoTaxa tutorials:

https://sites.google.com/view/piqv/piqv-manuals/ecotaxaecopart-manuals?authuser=0

https://www.youtube.com/watch?v=PSO6ZS765tk

https://www.youtube.com/watch?v=RaWUqIoKk0E
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